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DataCAD Plus ZAC helps increase your productivity by 
automating repetitive design tasks. Based on the concept of 
making variations on a basic zone, you can quickly design and 
generate construction documents for a multilevel building. 

This manual serves both as a tutorial and a reference tool. This 
chapter introduces you to ZAC with a brief overview. The 
tutorial (Chapters 2 through 6) guides you while you draw a 
ZAC building. The remaining chapters and the Appendix 
contain detailed instructions and reference information about 
the ZAC program features. 

In this chapter: 

± Concepts and terms 

± ZAC icon bar 

± Navigation and input 
aids 

± Test drive ZAC 
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Introducing ZAC Concepts and Terms 
ZAC (Zone-based Architectural Construction) is a design tool that will help you 
reduce repetitive work and increase productivity. For example, in a 15-story 
building, many of the floors will be exactly the same, while others will have minor 
variations (such as different window styles or modified floor plans to accommodate 
more offices) based on your client’s requirements. Rather than starting from scratch 
on each floor, ZAC lets you copy the basic data from one floor to another. Then, 
ZAC helps you to make those changes rapidly and painlessly. 

Even a single-story building can take advantage of the ZAC concept. For example, a 
single-story school’s classrooms can all be based on one zone. Then, you could 
make minor changes to each classroom. 

ZAC relies on the concept of a basic theme and variations. For centuries, this 
concept has been successfully used in the music field (from Bach to Brubeck to the 
Beatles and beyond) where melody A changes slightly to become melodies A-1, A-2, 
and A-3. As you develop proficiency with ZAC, you will see many more 
opportunities where you can use this powerful design tool.  

Some of the concepts and terms used in the ZAC program are familiar, while others 
will soon become part of your everyday thought process as far as architectural 
design is concerned. 

Drawing 
Your entire project is stored in a computer file that DataCAD Plus calls a drawing. In 
this file, there are several layers containing details that relate to different building 
components (such as windows, doors, and walls). For information about naming, 
working with, and managing drawing files, see Chapter 2 in the DataCAD Plus 
Reference Manual.  

Plan 
A plan is a paper summary (a print or plot) of your drawing, including the 
information from different layers within your file. 

Database 
A database is a structured collection of information. ZAC relies heavily on several 
databases that contain information about building components such as windows, 
doors, and walls. For example, the ZAC windows database contains records for 
many shapes, sizes, and types of windows that you can use in your drawing. 
Although DataCAD Plus supplies many records in this database, you can also edit 
existing ones or add new/custom windows (see Chapter 9 in this manual for details 
on editing and adding to databases). 
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One of the most familiar databases is a telephone book. Each line (known as a 
record) contains information about one person. That record contains several fields 
with specific pieces of information about that person. One field holds the person’s 
name, a second field contains the street address, and a third has the phone number. 
Some fields can only contain numbers (such as the phone number), while others 
will accept letters and other characters (such as the name and address fields). The 
person who designed the database makes these decisions and determines the 
maximum characters, numbers, or other typographic symbols each field can hold 
(maximum field length). 

 ZAC 
This is the acronym for Zone-based Architectural Construction. 

Zone 
A zone links building elements which share a common, logical design purpose and 
Z-height within a defined area. The zone encompasses the layer-spanning 
information (about such things as walls, openings, stairs, shading, dimension 
strings, and text) you want to connect into a distinctive, logical, easy-to-change 
group. Basically, a zone contains all the things that you want to keep together when 
you plot or print your plan on paper.  ZAC helps you control, collect, and connect 
the various purpose- and dimension-dependent elements in your plan. 

A zone can be as small as part of a room or as large as the footprint of a building. 
For example, in a 15-story building, each floor could be a separate zone. And each of 
those zones could be based on the same fundamental information, with minor 
variations (such as different window styles). In a one-floor, sprawling industrial 
plant, you could have several zones (such as the shipping area, production floor, 
and administrative offices) where different Z-heights and dimension strings would 
be the distinguishing factors. 
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Using the Context-sensitive ZAC Icon Bar 
Some DataCAD Plus icon bars appear only when you perform certain functions. 
These icon bars are called context-sensitive. When the program needs them, they 
open on your screen. At other times, they are dormant.  

This ZAC icon toolbar appears after you activate ZAC on the switch bar and select 
ARCHTECT from the Edit menu: 

 

When you switch to another Edit or Utility menu (such as Mirror or Hatch), the 
ZAC icon toolbar disappears. It disappears because the functions controlled by 
those icons are temporarily unavailable. The dormant context-sensitive ZAC icon 
bar looks like this: 

  

If the context-sensitive menu does not appear, select the Display pull-down menu, choose 
Toolbars, and make sure that Context Icon Bar is activated. An option is activated when there 
is a checkmark in front of it. 
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Navigating Through the ZAC Program 
As with regular 2D and 3D DataCAD Plus drawings, you often can use several 
ways to navigate through ZAC: menus, keyboard shortcuts, and icons. 

At first, you may rely on the menus. As you become more familiar with the 
program, you will probably want to bypass many menus. Then, you can use 
keyboard shortcuts and icons to quickly access the menus and functions you want. 

Menus 
ZAC uses most of the regular DataCAD Plus menus that you can dock to the 
margin of the drawing window or float anywhere on your screen (even outside the 
drawing window).  The pull-down menu bar lets you access dozens of functions, 
too. Both menu systems are described in the DataCAD Plus Reference Manual. 

The most striking difference between the regular DataCAD Plus and ZAC menus is 
the ARCHTECT button in the EDIT menu. (If ZAC is not active, this menu item 
changes to Architct.) 

Selecting ARCHTECT from the EDIT menu displays the ARCHTECT menu and the 
ZAC icon bar. The ARCHTECT menu gives you access to the ZAC program 
functions. Your screen looks similar to this: 
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Keyboard Shortcuts 
Since most people who use a program daily quickly tire of going through multiple 
menus to access the functions they want to use, DataCAD Plus gives you many 
keyboard shortcuts. These one- or two-key shortcuts instantly deliver you to the 
menu you want. For a comprehensive list of these keyboard shortcuts, see the 
Appendix in the DataCAD Plus Reference Manual. 

For example, if you press the combination [Alt]+[E], DataCAD Plus immediately 
brings you to the Enlarge menu instead of going through layers of menus. Likewise, 
[Alt]+[L] takes you to the LineType menu and [M] to the Move menu. 

Icons 
Icons are symbols that represent program options. If you move your cursor over an 
icon, a brief description or “tooltip” appears beneath it.  

If the tooltip does not appear, select the Extras pull-down menu, choose Options, and make 
sure that Show Quick-Info is activated (checked). 

Icons are mouse shortcuts to popular DataCAD Plus functions. In this way, they are 
similar to keyboard shortcuts. Just clicking on an icon lets you bypass intermediate 
menus, taking you directly to the one that controls the function you want to use. 
This is a great way to save time. 

The context-sensitive ZAC icons are placed in a convenient bar that appears when 
you activate ZAC on the switch bar and select ARCHTECT from the menu. 
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A simple click of the mouse lets you use all the other icons that appear in the 
various toolbars on your DataCAD Plus screen. These icons instantly perform 
functions (such as Undo, Save Current Drawing, or Launch Object Viewer) or bring 
you to the appropriate menu (such as Copy, Erase, or Define Hatch Patterns). If you 
aren’t sure what an icon does, you can use the tooltip as a guide. 

Keyboard Input 
You assure precision in your ZAC project by entering measurements, designating 
angles, using reference points, changing coordinate systems, switching layers, and 
selecting items from databases. Often, this requires you to use special keys: 

[`] – Specify a reference point; sets the relative point to 0, 0 

[N] – Snap point; use this if you have no middle mouse button  

[Spacebar] – Initiate keyboard input of values; press [Enter] to confirm 

[Backspace] – Open a database when in a ZAC function 

[Tab] – Move from one input field downward to another in a dialog box when in a 
ZAC function; scroll through active layers when a database is not open 

[Shift]+[Tab] – Move from one input field upward to a previous one in a dialog box; 
scroll backwards through the active layers 

[Enter] – Confirm that values or database selections are OK; enter a point  

[Insert] – Change to a different coordinate system (ABS POL, REL CART, etc.) 

Zoom and Pan 
If you want to see more details or pull back to get the full picture of your ZAC 
drawing, you will use the zoom functions. If saving time is not a priority, you can 
use the menus to zoom in and out; however, most DataCAD Plus users want 
quicker results. For a little more speed, you can use the mouse to select the zoom 
icons. By far, the quickest way to zoom and pan is with these keyboard shortcuts: 

[/] – Zoom in after stretching the rubberband around the area you want to examine 

[PgDn] – Zoom in 

[PgUp] – Zoom out 

[ß] – Pan left 

[à] – Pan right 

[á] – Pan up 

[â] – Pan down 
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Previewing the DataCAD Plus ZAC Program 
To test drive the ZAC program, you’ll make a little utility or garden shed. Don’t 
worry about aesthetics or precise measurements at this point.  

è To take the ZAC program for a fast spin around the block: 

1. Start the DataCAD Plus program and open a ZAC drawing by selecting the 
New Drawing tab in Start Assistant, highlighting the default file called 
zac_us.dc+, and choosing ARCHTECT from the Edit menu. The ZAC icon bar 
appears. 

 

2. Select the Create Walls icon and draw a rectangle. This is the beginning of your 
ZAC building.  

3. Choose the Create Windows icon and click twice on the wall (to define the 
jambs) and once outside (to define the outer window edge) the rectangular 
building. A window appears on your plan. For practice, you can add another 
window or two. 

4. Select the Create Doors icon and click twice on the wall and once outside the 
rectangular building. A door appears on your plan. If you want, add another. 

5. Click on the Create Roof Contours icon to bring up the ROOFCONS menu. 

6. Select Def Contr to reveal the Polyline menu. 

7. Choose ContSrch and click anywhere on the outside of the building’s external 
wall. A polyline appears around the building’s perimeter. Right-click once to 
return to the ROOFCONS menu. 

8. Select DefRoof to reveal the DefRoof menu. 

9. Click on GenRoof to go to the next menu. 

10. Turn off RoofExtn (if it’s on) and click anywhere on the roof polyline. ZAC 
generates a hip roof. 

è To see your first ZAC building: 

1. Choose ObjectViewer from the View pull-down menu or use the  icon. 

2. Click on the shed and rotate it with your mouse to get a good look at it from all 
angles. (All right, it’s not very pretty.) 

3. Click on the X in the upper right corner to exit the Visualisation screen. 
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Congratulations on completing your first ZAC building! In the tutorial chapters of 
this manual, you will learn how to design and modify a larger, more attractive 
structure. Then, you can apply the principles to your own projects. 

Feel free to save your garden or utility shed so that you can add improvements later 
when you learn more about ZAC and its capabilities. Select File/Save if you wish to 
save your project. 
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